Chapter 424

Two-Sample T-Tests Allowing Unequal Variance

Introduction

This procedure provides sample size and power calculations for one- or two-sided two-sample t-tests when no assumption of equal variances for the two population is made. This is commonly known as the Aspin-Welch test, Welch’s t-test (Welch, 1937), or the Satterthwaite method. The assumed difference between means can be specified by entering the means for the two groups and letting the software calculate the difference or by entering the difference directly.

The design corresponding to this test procedure is sometimes referred to as a parallel-groups design. This design is used in situations such as the comparison of the income level of two regions, the nitrogen content of two lakes, or the effectiveness of two drugs.

There are several statistical tests available for the comparison of the center of two populations. This procedure is specific to Aspin-Welch-Satterthwaite test. You can examine the sections below to identify whether the assumptions and test statistic you intend to use in your study match those of this procedure, or if one of the other PASS procedures may be more suited to your situation.

Other PASS Procedures for Comparing Two Means or Medians

Procedures in PASS are primarily built upon the testing methods, test statistic, and test assumptions that will be used when the analysis of the data is performed. You should check to identify that the test procedure described below in the Test Procedure section matches your intended procedure. If your assumptions or testing method are different, you may wish to use one of the other two-sample procedures available in PASS. These procedures are Two-Sample T-Tests Assuming Equal Variance, Two-Sample Z-Tests Assuming Equal Variance, Two-Sample Z-Tests Allowing Unequal Variance, and the nonparametric Mann-Whitney-Wilcoxon (also known as the Mann-Whitney U or Wilcoxon rank-sum test) procedure. The methods, statistics, and assumptions for those procedures are described in the associated chapters.

If you wish to show that the mean of one population is larger (or smaller) than the mean of another population by a specified amount, you should use one of the clinical superiority procedures for comparing means. Non-inferiority, equivalence, and confidence interval procedures are also available.
Test Assumptions

When running an Aspin-Welch-Satterthwaite t-test, the basic assumption is that the distributions of the two populations are normal. If that assumption is not likely to be met, another testing procedure, such as a non-parametric procedure could be used, and the corresponding procedure in PASS should be used for sample size or power calculations.

Test Procedure

If we assume that $\mu_1$ and $\mu_2$ represent the means of the two populations of interest, and that $\delta = \mu_1 - \mu_2$, the null hypothesis for comparing the two means is $H_0 : \mu_1 = \mu_2$ (or $H_0 : \delta = 0$). The alternative hypothesis can be any one of

- **Two-Sided:** $H_1 : \mu_1 \neq \mu_2$ (or $H_1 : \delta \neq 0$)
- **Upper One-Sided:** $H_1 : \mu_1 > \mu_2$ (or $H_1 : \delta > 0$)
- **Lower One-Sided:** $H_1 : \mu_1 < \mu_2$ (or $H_1 : \delta < 0$)

depending upon the desire of the researcher or the protocol instructions. A suitable Type I error probability ($\alpha$) is chosen for the test, the data is collected, and a $t$-statistic is generated using the formula:

\[
t = \frac{\bar{x}_1 - \bar{x}_2}{\sqrt{\frac{s_1^2}{n_1} + \frac{s_2^2}{n_2}}}
\]

This $t$-statistic follows a $t$ distribution approximately, with estimated degrees of freedom

\[
\frac{\left(\frac{s_1^2}{n_1} + \frac{s_2^2}{n_2}\right)^2}{\frac{1}{n_1-1} \left(\frac{s_1^2}{n_1}\right)^2 + \frac{1}{n_2-1} \left(\frac{s_2^2}{n_2}\right)^2}
\]

The null hypothesis is rejected in favor of the alternative if,

for $H_1 : \mu_1 \neq \mu_2$ (or $H_1 : \delta \neq 0$),

\[
t < t_{\alpha/2} \text{ or } t > t_{1-\alpha/2},
\]

for $H_1 : \mu_1 > \mu_2$ (or $H_1 : \delta > 0$),

\[
t > t_{1-\alpha},
\]

or, for $H_1 : \mu_1 < \mu_2$ (or $H_1 : \delta < 0$),

\[
t < t_{\alpha}.
\]

Comparing the $t$-statistic to the cut-off $t$-value (as shown here) is equivalent to comparing the $p$-value to $\alpha$. 
Power Calculation

This section describes the procedure for computing the power from \( n_1 \) and \( n_2 \), \( \alpha \), the assumed \( \mu_1 \) and \( \mu_2 \), and the assumed standard deviations, \( \sigma_1 \) and \( \sigma_2 \). Two good references for these general methods are Julious (2010) and Chow, Shao, Wang, and Lokhnygina (2018), although these texts do not specifically cover the Aspin-Welch-Satterthwaite t-test methods.

The figure below gives a visual representation for the calculation of power for a one-sided test.

If we call the assumed difference between the means, \( \delta = \mu_1 - \mu_2 \), the steps for calculating the power are as follows:

1. Find \( t_{1-\alpha} \) based on the central-\( t \) distribution with degrees of freedom,
   
   \[
   df = \frac{\left( \frac{\sigma_1^2}{n_1} + \frac{\sigma_2^2}{n_2} \right)^2}{\frac{1}{n_1-1} \left( \frac{\sigma_1^2}{n_1} \right)^2 + \frac{1}{n_2-1} \left( \frac{\sigma_2^2}{n_2} \right)^2}.
   \]

2. Calculate the non-centrality parameter:
   
   \[
   \lambda = \frac{\delta}{\sqrt{\frac{\sigma_1^2}{n_1} + \frac{\sigma_2^2}{n_2}}}
   \]

3. Calculate the power as the probability that the test statistic \( t \) is greater than \( t_{1-\alpha} \) under the non-central-\( t \) distribution with non-centrality parameter \( \lambda \):
   
   \[
   Power = \Pr_{\text{Non-central}-t}(t > t_{1-\alpha} \mid df, \lambda).
   \]

The algorithms for calculating power for the opposite direction and the two-sided hypotheses are analogous to this method.

When solving for something other than power, PASS uses this same power calculation formulation, but performs a search to determine that parameter.
A Note on Specifying the Means or Difference in Means

When means are specified in this procedure, they are used to determine the assumed difference in means for power or sample size calculations. When the difference in means is specified in this procedure, it is the assumed difference in means for power or sample size calculations. It does not mean that the study will be powered to show that the mean difference is this amount, but rather that the design is powered to reject the null hypothesis of equal means if this were the true difference in means. If your purpose is to show that one mean is greater than another by a specific amount, you should use one of the clinical superiority procedures for comparing means.

A Note on Specifying the Standard Deviations

The sample size calculation for most statistical procedures is based on the choice of alpha, power, and an assumed difference in the primary parameters of interest – the difference in means in this procedure. An additional parameter that must be specified for means tests is the standard deviation. Here, we will briefly discuss some considerations for the choice of the standard deviation to enter.

If a number of previous studies of a similar nature are available, you can estimate the variance based on a weighted average of the variances, and then take the square root to give the projected standard deviation.

Perhaps more commonly, only a single pilot study is available, or it may be that no previous study is available. For both of these cases, the conservative approach is typically recommended. In PASS, there is a standard deviation estimator tool. This tool can be used to help select an appropriate value or range of values for the standard deviation.

If the standard deviation is not given directly from the previous study, it may be obtained from the standard error, percentiles, or the coefficient of variation. Once a standard deviation estimate is obtained, it may useful to then use the confidence limits tab to obtain a confidence interval for the standard deviation estimate. With regard to power and sample size, the upper confidence limit will then be a conservative estimate of the standard deviation. Or a range of values from the lower confidence limit to the upper confidence limit may be used to determine the effect of the standard deviation on the power or sample size requirement.

If there is no previous study available, a couple of rough estimation options can be considered. You may use the data tab of the standard deviation estimator to enter some values that represent typical values you expect to encounter. This tool will allow you to see the corresponding population or sample standard deviation. A second rough estimation technique is to base the estimate of the standard deviation on your estimate of the range of the population or the range of a data sample. A conservative divisor for the population range is 4. For example, if you are confident your population values range from 45 to 105, you would enter 60 for the Population Range, and, say, 4, for ‘C’. The resulting standard deviation estimate would be 15.

If you are unsure about the value you should enter for the standard deviation, we recommend that you additionally examine a range of standard deviation values to see the effect that your choice has on power or sample size.
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are Power, Sample Size, Effect Size (Means or Difference), and Alpha. In most situations, you will likely select either Power or Sample Size.

The ‘Solve For’ parameter is the parameter that will be displayed on the vertical axis of any plots that are shown.

Test Direction

Specify whether the alternative hypothesis of the test is one-sided or two-sided. If a one-sided test is chosen, the hypothesis test direction is chosen based on whether the difference (δ = μ₁ - μ₂) is greater than or less than zero.

Two-Sided Hypothesis Test
H₀: δ = 0 vs. H₁: δ ≠ 0

One-Sided Hypothesis Tests
Upper:   H₀: δ ≤ 0 vs. H₁: δ > 0
Lower:   H₀: δ ≥ 0 vs. H₁: δ < 0

Power and Alpha

Power is the probability of rejecting the null hypothesis when it is false. Power is equal to 1 - Beta, so specifying power implicitly specifies beta. Beta is the probability obtaining a false negative with the statistical test. That is, it is the probability of accepting a false null hypothesis.

The valid range is 0 to 1. Different disciplines have different standards for setting power. The most common choice is 0.90, but 0.80 is also popular.

You can enter a single value, such as 0.90, or a series of values, such as .70 .80 .90, or .70 to .90 by .1.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
Pass Sample Size Software

Two-Sample T-Tests Allowing Unequal Variance

Alpha
Alpha is the probability of obtaining a false positive with the statistical test. That is, it is the probability of rejecting a true null hypothesis. The null hypothesis is usually that the parameters of interest (means, proportions, etc.) are equal.

Since Alpha is a probability, it is bounded by 0 and 1. Commonly, it is between 0.001 and 0.10. Alpha is often set to 0.05 for two-sided tests and to 0.025 for one-sided tests.

You can enter a single value, such as 0.05, or a series of values, such as .05 .10 .15, or .05 to .15 by .01. When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on \( N_1 \) or \( N_2 \) or both.

The options are

- **Equal \((N_1 = N_2)\)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter \( N_1 \), solve for \( N_2 \)**
  Select this option when you wish to fix \( N_1 \) at some value (or values), and then solve only for \( N_2 \). Please note that for some values of \( N_1 \), there may not be a value of \( N_2 \) that is large enough to obtain the desired power.

- **Enter \( N_2 \), solve for \( N_1 \)**
  Select this option when you wish to fix \( N_2 \) at some value (or values), and then solve only for \( N_1 \). Please note that for some values of \( N_2 \), there may not be a value of \( N_1 \) that is large enough to obtain the desired power.

- **Enter \( R = N_2/N_1 \), solve for \( N_1 \) and \( N_2 \)**
  For this choice, you set a value for the ratio of \( N_2 \) to \( N_1 \), and then PASS determines the needed \( N_1 \) and \( N_2 \), with this ratio, to obtain the desired power. An equivalent representation of the ratio, \( R \), is
  \[
  N_2 = R \times N_1.
  \]

- **Enter percentage in Group 1, solve for \( N_1 \) and \( N_2 \)**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed \( N_1 \) and \( N_2 \) with this percentage to obtain the desired power.

\( N_1 \) (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter \( N_1 \), solve for \( N_2 \)”

\( N_1 \) is the number of items or individuals sampled from the Group 1 population.

\( N_1 \) must be \( \geq 2 \). You can enter a single value or a series of values.

\( N_2 \) (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter \( N_2 \), solve for \( N_1 \)”

\( N_2 \) is the number of items or individuals sampled from the Group 2 population.

\( N_2 \) must be \( \geq 2 \). You can enter a single value or a series of values.
Two-Sample T-Tests Allowing Unequal Variance

R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1} \]

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this ratio are considered.

N2 is related to N1 by the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1 (e.g., \( N1 = 10 \) and \( N2 = 20 \), or \( N1 = 50 \) and \( N2 = 100 \)).

R must be greater than 0. If \( R < 1 \), then N2 will be less than N1; if \( R > 1 \), then N2 will be greater than N1. You can enter a single or a series of values.

Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2. Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)

Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter N1 and N2 individually**
  This choice permits you to enter different values for N1 and N2.

- **Enter N1 and R, where N2 = R * N1**
  Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

- **Enter total sample size and percentage in Group 1**
  Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N, and then N2 as N - N1.
Sample Size Per Group

This option is displayed only if Group Allocation = “Equal (N1 = N2).”

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for $N_1$, and also the value for $N_2$.

The Sample Size Per Group must be $\geq 2$. You can enter a single value or a series of values.

N1 (Sample Size, Group 1)

This option is displayed if Group Allocation = “Enter $N_1$ and $N_2$ individually” or “Enter $N_1$ and $R$, where $N_2 = R \times N_1$.”

$N_1$ is the number of items or individuals sampled from the Group 1 population.

$N_1$ must be $\geq 2$. You can enter a single value or a series of values.

N2 (Sample Size, Group 2)

This option is displayed only if Group Allocation = “Enter $N_1$ and $N_2$ individually.”

$N_2$ is the number of items or individuals sampled from the Group 2 population.

$N_2$ must be $\geq 2$. You can enter a single value or a series of values.

R (Group Sample Size Ratio)

This option is displayed only if Group Allocation = “Enter $N_1$ and $R$, where $N_2 = R \times N_1$.”

$R$ is the ratio of $N_2$ to $N_1$. That is,

$$R = \frac{N_2}{N_1}$$

Use this value to obtain $N_2$ as a multiple (or proportion) of $N_1$.

$N_2$ is calculated from $N_1$ using the formula:

$$N_2 = [R \times N_1],$$

where the value $[Y]$ is the next integer $\geq Y$.

For example, setting $R = 2.0$ results in a Group 2 sample size that is double the sample size in Group 1.

$R$ must be greater than 0. If $R < 1$, then $N_2$ will be less than $N_1$; if $R > 1$, then $N_2$ will be greater than $N_1$. You can enter a single value or a series of values.

Total Sample Size (N)

This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines $N_1$ and $N_2$.

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.

You can enter a single value or a series of values.

Percent in Group 1

This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.
**Effect Size**

**Input Type**
Indicate what type of values to enter to specify the effect size. Regardless of the entry type chosen, the test statistics used in the power and sample size calculations are the same. This option is simply given for convenience in specifying the effect size.

The difference is calculated using the formula

$$\delta = \mu_1 - \mu_2$$

The choices are

- **Means**
  Enter \( \mu_1 \) (Group 1 Mean) and \( \mu_2 \) (Group 2 Mean).

- **Difference in Means**
  Enter the difference, \( \delta \), directly.

Both choices also require you to enter the standard deviations, \( \sigma_1 \) and \( \sigma_2 \).

**Effect Size – Means**

**\( \mu_1 \) (Mean of Group 1)**
Enter a value for the assumed mean of Group 1. The calculations of this procedure are based on difference between the two means, \( \mu_1 - \mu_2 \). This difference is the difference at which the design is powered to reject equal means.

\( \mu_1 \) can be any value (positive, negative, or zero).

You can enter a single value, such as 10, or a series of values, such as 10  20  30, or 5 to 50 by 5.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

**\( \mu_2 \) (Mean of Group 2)**
Enter a value for the assumed mean of Group 2. The calculations of this procedure are based on difference between the two means, \( \mu_1 - \mu_2 \). This difference is the difference at which the design is powered to reject equal means.

\( \mu_2 \) can be any value (positive, negative, or zero).

You can enter a single value, such as 10, or a series of values, such as 10  20  30, or 5 to 50 by 5.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

**Effect Size – Difference in Means**

**\( \delta \)**
Enter a value for the assumed difference between the means of Groups 1 and 2. This difference is the difference at which the design is powered to reject equal means.

$$\delta = \mu_1 - \mu_2$$

\( \delta \) can be any non-zero value (positive or negative).

You can enter a single value, such as 10, or a series of values, such as 10  20  30, or 5 to 50 by 5.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
Standard Deviations

$\sigma_1$ (Standard Deviation 1)
The standard deviation entered here is the assumed standard deviation for the Group 1 population.

$\sigma_1$ must be a positive number.

You can enter a single value, such as 5, or a series of values, such as 1 3 5 7 9, or 1 to 10 by 1.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Press the small 'σ' button to the right to obtain calculation options for estimating the standard deviation.

$\sigma_2$ (Standard Deviation 2)
The standard deviation entered here is the assumed standard deviation for the Group 2 population.

$\sigma_2$ must be a positive number.

You can enter a single value, such as 5, or a series of values, such as 1 3 5 7 9, or 1 to 10 by 1.

When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Press the small 'σ' button to the right to obtain calculation options for estimating the standard deviation.
Example 1 – Finding the Sample Size

Researchers wish to compare two types of local anesthesia to determine whether there is a difference in time to loss of pain. Subjects will be randomized to treatment, the treatment will be administered, and the time to loss of pain measured. The anticipated time to loss of pain for one of the types of anesthesia is 9 minutes. The researchers would like to generate a sample size for the study with 90% power to reject the null hypothesis of equal loss-of-pain time if the true difference is at least 2 minutes. How many participants are needed to achieve 90% power at significance levels of 0.01 and 0.05?

Past experiments of this type have had standard deviations in the range of 1 to 5 minutes for Group 1, and at about 2.5 for Group 2. It is unknown which treatment has lower time to loss of pain, so a two-sided test will be used.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests Allowing Unequal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests Allowing Unequal Variance. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.01 0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Input Type</td>
<td>Means</td>
</tr>
<tr>
<td>μ1</td>
<td>11</td>
</tr>
<tr>
<td>μ2</td>
<td>9</td>
</tr>
<tr>
<td>σ1</td>
<td>1 to 5 by 1</td>
</tr>
<tr>
<td>σ2</td>
<td>2.5</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>μ1</th>
<th>μ2</th>
<th>δ</th>
<th>σ1</th>
<th>σ2</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.90538</td>
<td>30</td>
<td>30</td>
<td>60</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>1.0</td>
<td>2.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90607</td>
<td>21</td>
<td>21</td>
<td>42</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>1.0</td>
<td>2.5</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90085</td>
<td>40</td>
<td>40</td>
<td>80</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>2.0</td>
<td>2.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90032</td>
<td>28</td>
<td>28</td>
<td>56</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>2.0</td>
<td>2.5</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90315</td>
<td>59</td>
<td>59</td>
<td>118</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>3.0</td>
<td>2.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90637</td>
<td>42</td>
<td>42</td>
<td>84</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>3.0</td>
<td>2.5</td>
<td>0.050</td>
</tr>
</tbody>
</table>
Two-Sample T-Tests Allowing Unequal Variance

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>85</th>
<th>85</th>
<th>170</th>
<th>11.0</th>
<th>9.0</th>
<th>2.0</th>
<th>4.0</th>
<th>2.5</th>
<th>0.010</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.90097</td>
<td></td>
<td></td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>4.0</td>
<td>2.5</td>
<td>0.010</td>
<td></td>
</tr>
<tr>
<td>0.90</td>
<td>0.90187</td>
<td>60</td>
<td>60</td>
<td>120</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>4.0</td>
<td>2.5</td>
<td>0.050</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90140</td>
<td>119</td>
<td>119</td>
<td>238</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>5.0</td>
<td>2.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90202</td>
<td>84</td>
<td>84</td>
<td>168</td>
<td>11.0</td>
<td>9.0</td>
<td>2.0</td>
<td>5.0</td>
<td>2.5</td>
<td>0.050</td>
</tr>
</tbody>
</table>

References

Report Definitions
Target Power is the desired power value (or values) entered in the procedure. Power is the probability of rejecting a false null hypothesis.
Actual Power is the power obtained in this scenario. Because N1 and N2 are discrete, this value is often (slightly) larger than the target power.
N1 and N2 are the number of items sampled from each population.
N = N1 + N2 is the total sample size.
μ1 and μ2 are the assumed population means.
δ = μ1 - μ2 is the difference between population means at which power and sample size calculations are made.
σ1 and σ2 are the assumed population standard deviations for groups 1 and 2, respectively.
Alpha is the probability of rejecting a true null hypothesis.

Summary Statements
Group sample sizes of 30 and 30 achieve 90.538% power to reject the null hypothesis of equal means when the population mean difference is μ1 - μ2 = 11.0 - 9.0 = 2.0 with standard deviations of 1.0 for group 1 and 2.5 for group 2, and with a significance level (alpha) of 0.010 using a two-sided two-sample unequal-variance t-test.

These reports show the values of each of the parameters, one scenario per row.

Plots Section
These plots show the relationship between the standard deviation for Group 1 and sample size for the two alpha levels.

To specify the difference directly to get the same results, change **Input Type** to **Difference** and enter 2 for \( \delta \), leaving everything else the same. You may then make the appropriate entries as listed below, or open **Example 1b** by going to the **File** menu and choosing **Open Example Template**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Input Type</td>
<td><strong>Difference</strong></td>
</tr>
<tr>
<td>( \delta )</td>
<td>2</td>
</tr>
</tbody>
</table>

**Output**

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Target Power</th>
<th>Actual Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>( \delta )</th>
<th>( \sigma_1 )</th>
<th>( \sigma_2 )</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90</td>
<td>0.90538</td>
<td>30</td>
<td>30</td>
<td>60</td>
<td>2.0</td>
<td>1.0</td>
<td>2.5</td>
<td>0.010</td>
</tr>
<tr>
<td>0.90</td>
<td>0.90007</td>
<td>21</td>
<td>21</td>
<td>42</td>
<td>2.0</td>
<td>1.0</td>
<td>2.5</td>
<td>0.050</td>
</tr>
</tbody>
</table>

The results are the same as those obtained when the means are entered.
Example 2 – Finding the Power

Suppose a new corn fertilizer is to be compared to a current fertilizer. The current fertilizer produces an average of about 74 lbs. per plot. The researchers need only show that there is difference in yield with the new fertilizer. They would like to consider the effect of the number of plots used on the power of the test if the improvement in yield is at least 10 lbs.

Researchers plan to use a one-sided two-sample Aspin-Welch-Satterthwaite t-test with alpha equal to 0.05. Previous studies indicate the standard deviation for plot yield to be 24 lbs. for Group 1, and between 20 and 30 lbs for Group 2. The plot group sizes of interest are 10 to 100 plots per group.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests Allowing Unequal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests Allowing Unequal Variance. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>10 to 100 by 10</td>
</tr>
<tr>
<td>Input Type</td>
<td>Means</td>
</tr>
<tr>
<td>μ1</td>
<td>84</td>
</tr>
<tr>
<td>μ2</td>
<td>74</td>
</tr>
<tr>
<td>σ1</td>
<td>24</td>
</tr>
<tr>
<td>σ2</td>
<td>20, 25, 30</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>μ1</th>
<th>μ2</th>
<th>δ</th>
<th>σ1</th>
<th>σ2</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.25087</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.40528</td>
<td>20</td>
<td>20</td>
<td>40</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.53474</td>
<td>30</td>
<td>30</td>
<td>60</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.64110</td>
<td>40</td>
<td>40</td>
<td>80</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.72653</td>
<td>50</td>
<td>50</td>
<td>100</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.79385</td>
<td>60</td>
<td>60</td>
<td>120</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.84605</td>
<td>70</td>
<td>70</td>
<td>140</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.88598</td>
<td>80</td>
<td>80</td>
<td>160</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.91618</td>
<td>90</td>
<td>90</td>
<td>180</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.93880</td>
<td>100</td>
<td>100</td>
<td>200</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>20.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.22168</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>25.0</td>
<td>0.050</td>
</tr>
<tr>
<td>0.35293</td>
<td>20</td>
<td>20</td>
<td>40</td>
<td>84</td>
<td>74</td>
<td>10.0</td>
<td>24.0</td>
<td>25.0</td>
<td>0.050</td>
</tr>
</tbody>
</table>
These reports show the values of each of the parameters, one scenario per row.

### Plots Section

These plots show the relationship between the power and sample size for the three values of $\sigma^2$.

Again, to specify the difference directly to get the same results, change **Input Type** to **Difference** and enter **10** for $\delta$, leaving everything else the same. You’ll get the same results as those above.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Input Type</td>
<td>Difference</td>
</tr>
<tr>
<td>$\delta$</td>
<td>10</td>
</tr>
</tbody>
</table>
Example 3 – Finding the Difference

In some cases it may be useful to determine how different the means of two populations would need to be to achieve the desired power with a specific constrained sample size.

Suppose, for example, that 80 subjects are available for a study to compare weight loss regimens. Researchers would like to determine which of the two regimens is better. The anticipated weight loss after two months is anticipated to be about 20 lbs. The researchers would like to know how different the mean weight loss must be to have a study with 90% power when alpha is 0.05 and the standard deviation is assumed to be 6 lbs. for Group 1 and 8 lbs. for Group 2.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests Allowing Unequal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests Allowing Unequal Variance. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Effect Size (Means or Difference)</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>40</td>
</tr>
<tr>
<td>Input Type</td>
<td>Difference</td>
</tr>
<tr>
<td>δ</td>
<td>Search &gt; 0</td>
</tr>
<tr>
<td>σ1</td>
<td>6</td>
</tr>
<tr>
<td>σ2</td>
<td>8</td>
</tr>
</tbody>
</table>

Reports Tab

Means, Difference Decimals................. 3

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Power</th>
<th>N1</th>
<th>N2</th>
<th>N</th>
<th>δ</th>
<th>σ1</th>
<th>σ2</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.90000</td>
<td>40</td>
<td>40</td>
<td>80</td>
<td>5.195</td>
<td>6.0</td>
<td>8.0</td>
<td>0.050</td>
</tr>
</tbody>
</table>

If the true population mean weight loss for one group is 5.195 lbs. more or less than the other, the researchers would have 90% power to show a difference between the groups.
Example 4 – Validation of Sample Size using Simulation

We used the Tests for Two Means (Simulation) procedure to find the sample size needed for a two-sided test with alpha equal to 0.05, where the difference in means is 3.5, the standard deviation for Group 1 is 1 and the standard deviation for Group 2 is 3. The sample size result was 11 per group.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Two-Sample T-Tests Allowing Unequal Variance procedure window by expanding Means, then Two Independent Means, then clicking on Test (Inequality), and then clicking on Two-Sample T-Tests Allowing Unequal Variance. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Input Type</td>
<td>Difference</td>
</tr>
<tr>
<td>( \delta )</td>
<td>3.5</td>
</tr>
<tr>
<td>( \sigma_1 )</td>
<td>1.0</td>
</tr>
<tr>
<td>( \sigma_2 )</td>
<td>3.0</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for an Unequal-Variance T-Test</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \delta = \mu_1 - \mu_2 )</td>
</tr>
<tr>
<td>Hypotheses: ( H_0: \delta = 0 ) vs. ( H_1: \delta \neq 0 )</td>
</tr>
<tr>
<td>Target Power</td>
</tr>
<tr>
<td>0.90</td>
</tr>
</tbody>
</table>

The sample size of 11 per group matches the simulation result exactly.